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Chapter 244

Tests for the Difference
Between Two Poisson
Rates in a ClusterRandomized Design with
Adjustment for Varying
Cluster Sizes
Introduction
This procedure calculates power and sample size for tests of two means in a cluster-randomized design in which
the outcome variable is a count. It uses the work of Wang, Zhang, and Ahn (2018) which give the power for the
case of varying cluster sizes. The analysis is of a simple z-test comparing the two means.

Technical Details
The following discussion summarizes the results in Wang, Zhang, and Ahn (2018).
Suppose you are interested in comparing the means of two groups (treatment and control). Further suppose that
the response is known to be related to other covariates (such as age, race, or gender) and so their impact needs to
be adjusted for. This may be accomplished by stratifying on the covariates and forming hypotheses about a
common mean difference across all clusters and strata. Often, the stratification is based on cluster size, but this is
not required.
Let 𝑌𝑌𝑗𝑗𝑗𝑗𝑗𝑗 be the count outcome of the ith �𝑖𝑖 = 1, … , 𝑛𝑛𝑗𝑗𝑗𝑗 � subject in the kth �𝑘𝑘 = 1, … , 𝐾𝐾𝑗𝑗 � cluster of the jth (𝑗𝑗 =
1,2) group. Assuming that 𝑌𝑌𝑗𝑗𝑗𝑗𝑗𝑗 follows a Poisson model with
𝜆𝜆𝑗𝑗 = E�𝑌𝑌𝑗𝑗𝑗𝑗𝑗𝑗 � = Var(𝑌𝑌𝑗𝑗𝑗𝑗𝑗𝑗 )

and a common intracluster correlation coefficient (ICC) 𝜌𝜌 = 𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐�𝑌𝑌𝑗𝑗𝑗𝑗𝑗𝑗 , 𝑌𝑌𝑗𝑗𝑗𝑗𝑖𝑖′ � for 𝑖𝑖 ≠ 𝑖𝑖 ′ .

244-1
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for the Diff. Between Two Poisson Rates in a C-R Design with Adj. for Varying Cluster Sizes

Test Statistic
An unbiased estimator of 𝜆𝜆𝑗𝑗 is
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Using a two-sided hypothesis 𝐻𝐻0: 𝜆𝜆1 = 𝜆𝜆2 versus 𝐻𝐻1: 𝜆𝜆1 ≠ 𝜆𝜆2 , H0 is rejected if
𝜆𝜆̂1 − 𝜆𝜆̂2

Sample Size and Power

�𝑠𝑠12 + 𝑠𝑠22

> 𝑧𝑧1−𝛼𝛼/2

Wang, Zhang, and Ahn (2018) provide the following formula for estimating 𝐾𝐾2 (the number of clusters in the
control group) when there are an unequal number of clusters in each group.
2
𝜆𝜆
�𝑧𝑧1−𝛼𝛼 + 𝑧𝑧1−𝛽𝛽 � � 𝑟𝑟1 + 𝜆𝜆2 �
1
2
𝐾𝐾2 =
�(1 − 𝜌𝜌) + 𝜌𝜌 + 𝜌𝜌𝛾𝛾 2 �
2
(𝜆𝜆1 − 𝜆𝜆2 )
𝜃𝜃

where 𝑟𝑟 = 𝐾𝐾1 /𝐾𝐾2 , 𝜃𝜃 = E(𝑛𝑛𝑗𝑗𝑗𝑗 ), 𝜏𝜏 2 = Var(𝑛𝑛𝑗𝑗𝑗𝑗 ), and 𝛾𝛾 = 𝜏𝜏/𝜃𝜃. Hence 𝜃𝜃 is the average cluster size of all clusters in
the study and 𝛾𝛾 is the coefficient of variation of the cluster sizes. Note that 𝑧𝑧𝑥𝑥 = Φ(𝑥𝑥) is the standard normal
distribution function.
This equation can easily be rearranged to provide a formula for power (1 − 𝛽𝛽).

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, refer to the Procedure Window chapter.

Design Tab
The Design tab contain most of the parameters and options of interest for this procedure.

Solve For
Solve For
This option specifies the parameter to be solved for using the other parameters. The parameters that may be
selected are 𝛿𝛿, Power, or K1 (Number of Clusters in Group 1). Select K1 (Number of Clusters in Group 1) when
you want to calculate the sample size needed to achieve a given power and alpha level. Select Power when you
want to calculate the power.
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Test
Alternative Hypothesis
Specify the alternative hypothesis, H1.
•

One-Sided (H1: δ < 0)
Refers to a lower-tailed, one-sided test with alternative hypothesis H1: δ < 0.

•

One-Sided (H1: δ > 0)
Refers to an upper-tailed, one-sided test with alternative hypothesis H1: δ > 0.

•

Two-Sided (H1: δ ≠ 0)
Refers to a two-sided test with alternative hypothesis H1: δ ≠ 0.

Power and Alpha
Power
Power is the probability of rejecting the null hypothesis when it is false. Power is equal to 1 - Beta, so specifying
power implicitly specifies beta.
Beta is the probability of obtaining a false negative with the statistical test. That is, it is the probability of
accepting a false null hypothesis.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. For this procedure, a type-I error occurs when you reject the null hypothesis of equal
group means when in fact they are equal.
Values must be between zero and one. Historically, an alpha value of 0.05 has been recommended for two-sided
tests and 0.025 for one-sided tests. You should pick a value for alpha that represents the risk of a type-I error you
are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size – Number of Clusters and Cluster Size
K1 (Clusters in Group 1)
Enter one or more values for the number of clusters in group 1. The number of subjects in this group is equal to
the number of clusters times M, the mean cluster size.
This value must be a positive number. You can use a list of values such as 10 20 30.
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K2 (Clusters in Group 2)
Enter one or more values for K2, the number of clusters in group 2: the control group.
If you simply want a multiple of the value for group 1, you would enter the multiple followed by “K1”, with no
blanks. If you want to use K1 directly, you do not have to enter the leading “1”. For example, all of the following
are valid entries: 10K1 2K1 0.5K1 K1.
You can use a list of values such as “10 20 30” or “K1 2K1 3K1”. K2 > 0. K2 is an integer.
Number of Subjects
The number of subjects is computed from the number of clusters using the mean cluster size.
M (Average of Cluster Sizes)
Enter one or more values for the average cluster size (number of subjects per cluster) across all clusters. Values
should be in the range M > 1.
This procedure lets the cluster sizes vary from cluster to cluster. The individual cluster size values are unknown at
the planning stage, so it is assumed that the cluster sizes are distributed according to a discrete distribution with a
certain mean and standard deviation. This option gives the mean cluster size and the next option gives the
standard deviation by asking for the cluster size coefficient of variation.
CV (Coefficient of Variation of Cluster Sizes)
Enter one or more values for the coefficient of variation of the cluster sizes (the value of 𝛾𝛾 in the equation above).
The coefficient of variation is the standard deviation of the cluster sizes divided by the mean cluster size.

This value can be any number greater than or equal to zero.

This procedure lets the cluster sizes vary from cluster to cluster. This results in a more accurate sample size
estimate than is obtained when the cluster sizes are assumed to be a fixed number.
The individual cluster size values are unknown at the planning stage, so it is assumed that the cluster sizes are
distributed according to a discrete distribution with a certain mean and standard deviation. This option gives the
standard deviation by asking for the cluster size coefficient of variation.
Discrete Uniform Distribution
A reasonable choice for an approximate discrete distribution of cluster sizes is the discrete uniform distribution
which is referred to as DU(A,B) in Wang, Zhang, and Ahn (2018). Here, A and B are the lower and upper
boundaries of a set of consecutive integers. The sample space consists of all integers between A and B, inclusive.
For example, the sample size of DU(1,6) is the integers 1, 2, 3, 4, 5, 6, each occurring with an equal probability.
This is the distribution of a single dice.
The mean of DU(A,B) is (A+B)/2.
The variance of DU(A,B) is [(B-A+1)² - 1]/12.
Hence, the CV can be easily calculated.
Here are some examples which may be easily verified.
Distribution Mean
DU(40, 60)
50
DU(25,75)
50
DU(70, 130)
100

Variance
36.67
216.67
310.00

CV
0.12111
0.29439
0.17607
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Effect Size
Enter λ1 or δ
This option lets you indicate how you want to enter λ1.
The options are
•

λ1 (Event Rate of Group 1)
Enter the value of λ1 directly.

•

δ (Difference = λ1 - λ2)
Enter values for the difference between the means. The value of λ1 is equal to λ2 + δ.

λ1 (Mean of Group 1)
Enter a value (or range of values) for the mean count per subject in group 1, the treatment group. If Y is a random
variable giving the count for a subject in this group, then λ1 = E(Y).
For example, Y might be the number of visits to the doctor during pregnancy, the number of cigarettes smoked, or
the number misbehaviors by a child. The point to realize is that Y is a count value for a particular subject.
This value is used with λ2 to calculate the effect size. The difference λ1 - λ2 represents the difference you want to
detect with a specified power.
This value must be positive.
You can enter a single value such as “1.0” or a series of values such as “1.0 1.2 1.4” or “1 to 2 by 0.5”.
λ2 (Mean of Group 2)
Enter a value (or range of values) for the mean count per subject in group 2, the control group. If Y is a random
variable giving the count for a subject in this group, then λ2 = E(Y).
For example, Y might be the number of visits to the doctor during pregnancy, the number of cigarettes smoked, or
the number misbehaviors by a child. The point to realize is that Y is a count value for a particular subject.
This value is used with λ1 to calculate the effect size. The difference λ1 - λ2 represents the difference you want to
detect with a specified power.
This value must be positive and unequal to λ1.
You can enter a single value such as “1.0” or a series of values such as “1.0 1.2 1.4” or “1 to 2 by 0.5”.
δ (Difference = λ1 - λ2)
Enter a value (or range of values) for the mean difference between the two groups that you want to detect.
This value must be non-zero.
You can enter a single value such as “1.0” or a series of values such as “1.0 1.2 1.4” or “1 to 2 by 0.5”.
ICC (Intracluster Correlation)
Enter a value for ICC, the intracluster correlation coefficient. This may be thought of as the correlation between
any two observations in the same cluster.
Note that occasionally, ICC < 0.
You may enter a single value or a list of values.
Since this is a correlation coefficient, it is possible for it to range from -1 to 1.
You may enter a range of values such as 0.01 0.02 0.03.
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Example 1 – Finding the Number of Clusters
A study is being planned to investigate whether a new intervention will decrease a certain response variable. This
response is a count. For a number of reasons, the researchers decide to administer the intervention to whole
clusters (clinics) rather than randomize the treatment to individuals within the cluster. The number of clinics
receiving each treatment will be balanced.
The average number of subjects per clinic is 21. The coefficient of variation of the cluster sizes is 0.42.
Prior studies have obtained a base-line mean score of 8.4 and an ICC of 0.31. The researchers want to compare
the necessary numbers of clusters when the change in the mean score is -1, -2, and -3.
The two-sided significance level is set to 0.05 and the power is set to 0.9.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load this procedure. You may then make the appropriate entries as listed below, or open Example 1 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... K1 (Number of Clusters in Group 1)
Alternative Hypothesis ................................... Two-Sided (H1: δ ≠ 0)
Power ............................................................. 0.90
Alpha .............................................................. 0.05
K2 (Clusters in Group 2) ................................ K1
M (Average of Cluster Sizes)......................... 21
CV (Coeff. of Variation of Cluster Sizes) ....... 0.42
Enter λ1 or δ .................................................. δ (Difference = λ1 - λ2)
δ (Difference = λ1 - λ2) .................................. -1 -2 -3
λ2 (Mean of Group 2)..................................... 8.4
ICC (Intracluster Correlation) ......................... 0.31

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: δ = 0 vs. H1: δ ≠ 0

Power
0.9235
0.9096
0.9000

Sample
Size
N
294
672
2772

Clus Clus Clus
Cnt
Cnt
Cnt
Total Grp 1 Grp 2
K
K1
K2
14
7
7
32
16
16
132
66
66

Alloc
Ratio
K1/K2
1.00
1.00
1.00

Clus
Clus Size
Mean IntraSize Coef Mean Mean
Diff Clus
Ave
Var Grp 1 Grp 2 λ1-λ2 Corr
M
CV
λ1
λ2
δ
ICC Alpha
21 0.420 5.40 8.40 -3.00 0.310 0.050
21 0.420 6.40 8.40 -2.00 0.310 0.050
21 0.420 7.40 8.40 -1.00 0.310 0.050

References
Wang, J., Zhang, S., and Ahn, C. 2018. 'Sample size calculation for count outcomes in cluster randomization
trials with varying cluster sizes.' Communications in Statistics--Theory and Methods, DOI:
10.1080/03610926.2018.1532004.
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total sample size, i.e., the total number of subjects from all clusters.
K is the total cluster count. It is the total number of clusters.
K1 is the number of clusters assigned to group 1, the treatment group.
K2 is the number of clusters assigned to group 2, the control group.
K1/K2 is the allocation ratio. This is the number of group 1 clusters divided by the number of group 2 clusters.
M is the average cluster size. It is the average number of subjects per cluster based on all cluster sizes.
CV is the coefficient of variation of the cluster sizes. It is the standard deviation of cluster sizes divided by the
average cluster size.
λ1 is mean number of events per subject in group 1, the treatment group.
λ2 is mean number of events per subject in group 2, the control group.
δ = λ1 - λ2 is the mean difference assumed by the alternative hypothesis. This is the difference at which the
power is computed.
ICC is the intracluster correlation coefficient. This is the correlation between any two subjects within a particular
cluster.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements ─────────────────────────────────────────────────────────
A cluster randomized design consists of 7 clusters in the treatment and 7 clusters in the control group for a grand
total of 14 clusters. The number of events for each subject is the outcome (response) variable. The difference
between the two group means is analyzed using a two-sided z-test. The expected sample size of 294 subjects
achieves 92% power to reject the mean difference of zero assumed by the null hypothesis when the difference is
actually -3.00. This difference is calculated from the treatment mean of 5.40 and the control mean of 8.40. The
intracluster correlation coefficient is 0.310. The significance level of the test is 0.050. The individual cluster sizes
(the number of subjects per cluster) are assumed to vary according to a discrete distribution with mean 21 and
coefficient of variation 0.420.

Plots Section

The values from the Numerical Results report are displayed in this plot.
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Example 2 – Validation using Wang, Zhang, and Ahn (2018)
Wang, Zhang, and Ahn (2018) provide an example of sizing a cluster-randomized study. We will use their results
to validate this procedure.
The average number of subjects per cluster was expected to be 50. Three coefficients of variation were
investigated: 0, 0.12111, and 0.29439. These corresponded to discrete uniform distributions of DU(50,50),
DU(40,60), and DU(25,75). Note that DU(50,50) is a case in which all cluster sizes were equal to 50 and the
coefficient of variation was 0.
The treatment mean was set at 4.35 and the control mean was set at 3.63. The ICC was set at 0.32. A two-sided
test at a significance level of 0.05 is planned. The necessary number of clusters per group was calculated as 54,
55, and 59.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load this procedure. You may then make the appropriate entries as listed below, or open Example 2 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... K1 (Number of Clusters in Group 1)
Alternative Hypothesis ................................... Two-Sided (H1: δ ≠ 0)
Power ............................................................. 0.90
Alpha .............................................................. 0.05
K2 (Clusters in Group 2) ................................ K1
M (Average of Cluster Sizes)......................... 50
CV (Coeff. of Variation of Cluster Sizes) ....... 0 0.12111 0.29439
Enter λ1 or δ .................................................. λ1 (Mean Count of Group 1)
λ1 (Mean of Group 1)..................................... 4.35
λ2 (Mean of Group 2)..................................... 3.63
ICC (Intracluster Correlation) ......................... 0.32

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: δ = 0 vs. H1: δ ≠ 0

Power
0.9002
0.9015
0.9027

Sample
Size
N
5400
5500
5900

Clus Clus Clus
Cnt
Cnt
Cnt
Total Grp 1 Grp 2
K
K1
K2
108
54
54
110
55
55
118
59
59

Alloc
Ratio
K1/K2
1.00
1.00
1.00

Clus
Clus Size
Mean IntraSize Coef Mean Mean
Diff Clus
Ave
Var Grp 1 Grp 2 λ1-λ2 Corr
M
CV
λ1
λ2
δ
ICC Alpha
50 0.000 4.35 3.63 0.72 0.320 0.050
50 0.121 4.35 3.63 0.72 0.320 0.050
50 0.294 4.35 3.63 0.72 0.320 0.050

PASS has obtained K1 values of 54, 55, and 59.
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